Drumlin PDF Secure Reader/Publisher

Drumlin Security Ltd
Drumlin PDF Secure Reader/Publisher

© 2015 Drumlin Security Ltd

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.
Table of Contents

Part I Introduction 1-2
- Installing and Registering Drumlin ......................................................... 1-4
- File types supported .................................................................................. 1-6
- Creating and Publishing Secure PDF files ............................................... 1-9
- Technical support ....................................................................................... 1-12
- Tailoring Drumlin ...................................................................................... 1-13

Part II Using the Drumlin PDF Reader 2-2
- Navigation .................................................................................................. 2-4
- Authorizing DRMX files using Drumlin ..................................................... 2-8
- Copying content ......................................................................................... 2-10
- Bookmarking ............................................................................................ 2-11
- Language selection ................................................................................... 2-12
- Preferred settings selection ...................................................................... 2-13
- Printing ..................................................................................................... 2-15

Part III Secure PDF Publishing 3-2
- Document info tab ...................................................................................... 3-4
- Document type tab .................................................................................... 3-5
- Document permissions tab ....................................................................... 3-7
- Document watermarking tab ................................................................... 3-10
- Userlist facility .......................................................................................... 3-12
- Batch publishing ....................................................................................... 3-14
- Keeping track ............................................................................................ 3-16
- Reporting and control .............................................................................. 3-17
- Web hosting secured files ....................................................................... 3-18
- Re-publishing secure PDFs ...................................................................... 3-19

Part IV Publishing Javelin and "Click and Go" files 4-2
- Command line options .............................................................................. 4-5

Part V Antivirus software issues 5-2

Part VI Other authorization options 6-2

Part VII Catalogs 7-2
Part VIII  Authorization codes and Admin facilities  8-2

Index  0
Part I

Introduction
Introduction

This manual provides information and guidance on the use of the Drumlin secure PDF Publisher. Drumlin software is used to create secured PDF files from existing PDF files with extensive controls available to the publisher, e.g. how many times the document can be viewed, whether it can be printed, when viewing can start and when viewing is no longer permitted etc.. These secured PDF files are given a file extension .DRMX or .DRMZ, so if you start with myfile.pdf and use the Drumlin software, File menu, Publish option, it will create a secured PDF with the permission settings you specify and by default the output file, saved to your local disk, will be called myfile.drmz or myfile.drmx - note that this secured PDF is actually structured as two separate blocks of data within an "envelope" or "wrapper":

(i) the first block contains a range of information relating to the file and its permissions settings. These include the unique documentID assigned to the file by our Digital Rights Management (DRM) system, the start and end dates for the document (i.e. when it is allowed to be viewed from and to), counter variables, such as the number of times the file may be viewed (usually set to -1 which means unlimited), the number of times it may be printed (usually set to 0 for never), the number of pages that may be printed (also usually set to 0), and other control details specified when the file is created; and

(ii) the second block contains the secured PDF file itself - with drmx files this is a strongly encrypted block and can be viewed on desktop and laptop computers using our Javelin readers for Windows and Mac computers, and for drmz files the coding is lighter-weight so can be read on mobile devices also, again using the free Javelin readers for these platforms.

DRMZ files are required for full cross-platform working - i.e. for Desktop/laptop AND mobile devices. Having created a secured PDF, e.g. myfile.pdf as myfile.drmz, you can then distribute these files to your customers/end users, together with instructions on how to view and/or print them using our free Javelin PDF readers. Javelin readers are available as free downloads from the major App Stores and our Javelin download page: http://www.drumlinsecurity.com/javelindownloads.html

A document securely published using the Drumlin Publishing function and opened with our Javelin secure PDF readers can only be viewed on the specific computer and/or by the specific user that has been authorized for this document. DRMX, DRMZ and EXE files (the latter for Windows PCs only) require authorization codes or license files in order for the files to be read and/or printed.

We recommend that publishers thoroughly test their secured files on a wide range of computers and operating system variants, and using test/real users to check the security and to ensure the files operation in the manner you plan. This includes testing the files created with new releases of the software (see further, the Drumlin and Javelin License terms). As a quick check on the display and navigation aspects of a PDF file you wish to publish securely, please use Javelin for Windows to open your source PDF and test it in this way, i.e. even before you add security features.

If you are an end user you will typically simply have Javelin plus a DRMX or DRMZ file, or a PDF ebook or other publication that is wrapped in a Javelin program (e.g. myfile.exe).

Please see our demos page for visual presentations of some of our products. Updates to the product set are listed on the Release Notes page.

Drumlin Security Ltd provides a range of components and solutions for PDF Security, including:

• Drumlin: the main Drumlin PDF Reader/Publisher software

• AdminApp: the program that is used to create authorization codes and license files, and to track and report on usage

• Javelin: the Javelin PDF readers for PCs running Windows and Apple Mac OSX computers, and mobile device apps (Apple iPad/iOS and Android devices).
• Offline PDF security: Drumlin Content Management - our DRM server software available as a web based service or as a bespoke solution.

• Online PDF security: web hosted solutions based on PDF conversion to protected Flash and HTML/image formats - see our website, Managed Online Services, for more details

Drumlin and AdminApp are available for Microsoft Platforms running MS Windows NT/2000/XP, Vista and Windows 7 and later, with the latest versions supporting 32bit and 64bit platforms. Computers running Mac OS and Linux OS variants can run Drumlin using standard virtualization software, as explained on our website (e.g. Parallels with Windows 8).

For users with a particular application, e.g. in eBook publishing, Engineering, Financial and Legal documents, or Training materials, please see the linked pages on our website about specific solutions for these sectors.

For users requiring more detailed technical information we recommend reading our website pages, our PDF Publishing News blog and our PDF documentation. The available documents include:

• PDF Newsletters - regular newsletters sent to our publishers and contacts by email

• Our PDF Publishing News blog for more news and commentary on "The Future of PDF Publishing"

• Drumlin Installation Guide - a PDF file providing guidance on how to install and register Drumlin.

• Javelin User Guides: Available online from: http://www.drumlinsecurity.com/documentation.html


PCs running Javelin must be able to run a newly loaded exe file (some corporate desktop's are locked-down to prevent any new exe files being run) - Javelin for Windows is a signed application (as is Drumlin) with no system dependencies, so in most instances it is acceptable on corporate systems, although remote access to the DRM server may be restricted on some sites (e.g. by proxy servers or firewalls). Modern proxy server support is provided for in the Javelin for Windows software so technical issues with corporate environments can be readily resolved. The JavelinPro version of our Javelin reader for Windows can be used to enable offline authorization using license files rather than authorization codes. All our software products have been checked to ensure they are virus free. Norton Antivirus users - if your antivirus software will not accept a download from us or deletes it/places it in quarantine, we are certain that this is a false positive. Please report this to Symantec as an error. To resolve this please either turn off the offending behavior in Norton's software (Insight and/or SONAR) or recover the quarantined file from within Norton Antivirus, or use another antivirus product like AVG!

Security notes
The details of the Drumlin software security framework, including both the software security and the service related security facilities, are not, of course, published. Publishers may ask us questions regarding to the security facilities available which we will endeavor to answer, and there are many publishing features and controls that are incorporated into the system but which are not apparent or visible. Ultimately it is the responsibility of the publisher to satisfy themselves, via thorough testing, that the solution provided meets their requirements.
Installing and Registering Drumlin

Installation

To install and register the Drumlin software please follow the instructions provided on the website download page:

http://www.drumlinsecurity.com/downloads.html

All our software products have been checked to ensure they are virus free. Norton Antivirus users - if your
antivirus software will not accept a download from us or deletes it/places it in quarantine, we are certain that this is
a false positive. Please report this to Symantec (or the appropriate provider of AV software) as an error. To resolve
this please either turn off the offending behaviour in Norton’s software (Insight and/or SONAR) or recover the
quarantined file from within Norton Antivirus, or use another antivirus product like AVG! To check any file you
are concerned about against 40+ AV software packages, without charge, we suggest that you use the website:

http://www.virustotal.com/index.html

For the main Drumlin PDF reader/publisher software you download the current kit from the downloads page, ex-tract
the contents of the zip file to a temporary directory, e.g. to c:\temp, and run the setup.exe program (see
sample image, below). This is a standard Microsoft Setup program and uses the Microsoft Installer (msi) to
complete the installation process. The files are very small compared with most PDF readers.

When complete there will be new items on the START menu, and a desktop icon for Drumlin that you can double-
click to run Drumlin.

Registration and re-registration

The first time you run Drumlin the software will prompt you to register - you need an active internet link to
complete the registration process and you have to provide a unique username and password (these are required
subsequently when you use AdminApp to create codes, licenses and track usage). If your location uses a Proxy
Server you may have to specify the Proxy Server details before being able to complete the registration process.
This is achieved via the File menu option, Use Proxy. You may need to contact your IT or Network administration
department to obtain the details required. For more information please see the downloadable PDF format
installation guide. If you need to change your computer, or have a system crash and/or operating system re-
install, please contact us for advice on re-registering.

In order to view most protected documents, and if you wish to become a publisher of such documents, your copy
of the Drumlin reader must be registered. This requires a connection to the Internet, so please ensure a
connection is available before you start. Then, go to the Help menu, REGISTER option (if you have not already
registered your software) to register your copy of the Drumlin software. Your registration details will be emailed to
you, and to enable continued use of the software you must respond to the email otherwise your software will
expire after a period (currently 5 years, but renewable thereafter).

The licensing terms and registration details can be viewed at any time via the Help menu, About option and on the
website.

To view a DRMX file on another computer using Drumlin a separate copy of the Drumlin reader must be installed
on that computer (e.g. a laptop), with its own registration details (a different username must be specified). More
typically, however, DRMX and DRMZ files will be read on other computers using the much lighter-weight Javelin
software (after authorization). In most instances publishers should create .DRMZ files and use Javelin for end
users, as this is cross-platform, very fast and very simple for end users, thus providing the minimum of support
requirements.
Updates

Our software is updated very regularly. The details of updates are provided on the release notes page. To update your software on Windows NT-compatible systems you can use the Update option on the Drumlin Help menu, but for Windows Vista and Windows 7 is it advisable to simply download a new kit and install this over your existing kit (see also, below) - your existing settings and files will be unaffected. Do not uninstall your previous kit first unless advised to do so by our technical support team.

If you are using Windows 7/8/10 or Vista and you select the Updates... option then you will probably get a message along the lines "You must be an admin user to do this..." - even if you are logged in as an admin user... this is how Microsoft have implemented some facilities on Win 7 and later and Vista. If you do see this it can be resolved by selecting the Drumlin shortcut (e.g. on your desktop) and right clicking it to see the properties form. You need to tick the box which allows you to run the application as an admin user ("elevated mode") and then use this shortcut to run the program. This will then permit you to use the Updates... facility.

If you are upgrading from Drumlin V5 to V6 you must read the Readmenv6.txt notes provide on the downloads page.
File types supported

Drumlin supports four main types of PDF file: standard PDF files (.PDF), basic secured PDFs (.DRM files - only used in specialized applications now), and fully secured PDF files (.DRMX and .DRMZ files). In general publishers will create .DRMX files or .DRMZ files, and for cross-platform and mobile device applications, .DRM is the file format to use. This is simply created using the .DRMX file format option with the iPAD/Android device compatible flag ticked (see below for full details).

Filenames for PDF and secured PDF files

File naming is a recurring issue so we thought we would include a comment on it here. This arose recently with a filename that was of the form filename3.1.2.pdf which thoroughly confused some Windows systems. To avoid problems of this kind we suggest the following:

Simple filenames: Try to keep filenames of the source PDFs short and simple, with no embedded spaces, hyphens or special characters. Avoid punctuation marks like full stops/period marks.

Renaming files: When securing a file with Drumlin it defaults the filename generated to be the same as the source PDF, usually with the extension .drmx or .drmz as appropriate. You can change the name of the drm or drmz file and it will remain essentially unchanged - Javelin and Drumlin inspect the document's internal documentID to decide on whether it requires authorizing so the name you assign does not matter.

Short filenames: are easier for end users to download if they have to type them in, and are less prone to problems such as browser related issues when provided via web links.

Lower case filenames: are a good idea if you host files on a linux/unix server rather than a Windows server, because linux and unix are case sensitive, so MyFile.pdf is different from myfile.pdf as far as the host server is concerned.

Standard PDF files

(.PDF extension) are supported within Drumlin in a similar manner to other PDF readers – all current PDF version files can be read and displayed. Navigation around the document is aided by support of zoom-in and zoom-out facilities, left and right mouse click operations, and wheel mouse and keyboard (PgUp/PgDn and arrow keys) support. Documents with built-in navigation trees are also supported, as are user-defined Bookmarks. Bookmarking of pages in any file is described later in this document. Buttons are also provided, as used in web browsers, enabling you go back and forth through the document following the paths (such as links) you have chosen. Javelin readers provide similar PDF reading functionality, varying according to the platform involved.

Drumlin provides tools for encrypting PDF files in a manner that is highly secure. These encrypted files are created (published) using Drumlin's File menu, Publish option. The resulting files are saved with a new file extension, .DRM or .DRMX or DRMZ and can only be read by the Drumlin PDF reader (DRMX files) or using our Javelin PDF readers (DRMX and DRMZ files). From Version 6 onwards the .DRMX file format has changed - .DRMX files created prior to this release can be read by Drumlin but not by the new Javelin reader. Publishers will need to regenerate previous DRMX files and exe files for the Version 6 release.

For most applications (except those requiring very strong levels of security) we recommend that the DRMZ file format is used, as this provides cross-platform distribution with small, fast files and simple, compact fast readers (Javelin readers for the various platforms - PC Win, Mac OSX, iPAD/iOS, Android).

Drumlin’s Fully secured PDF documents (.DRMX and .DRMZ files)

DRMX or DRMZ files require an authorization procedure to enable them for reading/printing.

- **Standard service**: with our standard service, when a user tries to open a DRMX or DRMZ file in Javelin, they are prompted for an authorization code. If they enter a valid code (which is checked on our Digital Rights Management server via the Internet) the document will be enabled for that device and user (note that it is the
device and user that are enabled for a file rather than the file itself).

- **Corporate/Pro service**: with the Corporate/Pro service a version of Javelin called JavelinPro should be used. This version of Javelin prompts the end user to register. Once registered details of their device are recorded, and this information can be used to create a device-specific license file for a particular document and user (this a facility within AdminApp, where it has been enabled for Corporate/Pro usage). User registration can be online or offline (the latter requiring details to be sent to the service manager by email), and document authorization is offline when license files are used, or if no license file is found, it defaults to online authorization by authorization code, as per the standard edition.

Note: If you create an issue a DRMX file and someone has the file, but not yet authorized it, and then for some reason you re-generate the same file (as a DRMX) it will cause a problem, because DRMX files use a random split key system. So the first time the file is generated it has a key A, say, and this is split into A1 (in the file) and A2 on our server - the file only works if the two parts match. Then suppose you re-generate the file, and this uses random key B this time. So the two parts of the encryption key are now B1 and B2. Then if the user has the older version with A1 and the server has the new version B2, the two parts will not match and cannot be authorized. This is not generally a problem, but can arise if files are issued, hang around for a longish time and the original file is re-generated before the original copy has been authorized. The solution is to avoid re-generating from the same named PDF if you are creating DRMX files, unless you ensure the clients always receive the latest version, or use DRMZ files which do not use split keys so do not have the potential problem.

**Drumlin’s Fully secured PDF documents (.EXE files)**

These are DRMX files that have been converted to EXE form using the Drumlin File menu, Publishing facilities. EXE files are specific to the Windows platform - cross-platform users should provide Javelin plus the relevant DRMX or DRMZ file to their customers rather than a bundled exe file. A DRMX file that has been converted to EXE form has the same document ID (DocID) but is wrapped in our Javelin “Click and Go” secure PDF reader for Windows.

In addition, two further types of EXE files are supported (MS Windows only):

- offline authorized files – for these files no online connection is required. The customer downloads the relevant exe file, runs it, and provides a username and email address (used at the time of requesting the file from the provider), together with a special authorization code (like a software installation license number) that they enter (e.g. paste in from an email they receive). The two sets of data are compared and if OK the file is locally authorized

- files that require no authorization, so are secured in terms of copying/printing/date etc, but not restricted to a particular user’s PC – these files can just be run, like any other standalone executable. This form of file is useful for delivery of samples/extracts etc with no authorization required, but may have security features included (e.g. date expiry)

Although very convenient for end users, exe files have a number of disadvantages:

- once built the version of Javelin used cannot be updated, so new features or fixes cannot be provided other than by the end user downloading a new version of the document or documents in exe form

- exe files can be more difficult to distribute because virus scanners treat them with great suspicion - and in general such files are not "signed" so cannot be attributed to the provider

- exe files are slightly more bulky, as they include the reader (which is very small though)

- exe files are only available for Windows and .DRMX files - for cross platform usage .DRMZ files and a separate Javelin reader should be used

As an alternative to issuing exe files for Windows users, it is possible to issue a simple installation kit that contains a link to run Javelin for Windows with the target file as the first argument in the command line, i.e. of the form "javelin.exe myfile.drmz"
Drumlin's Basic secured PDF documents (.DRM files)

The "Basic" secured PDF option does not require authorization in order to open and/or print them – so if you create or are sent a Basic DRM file you can open it immediately - anyone with Drumlin installed can read it, although you can require that such installation belong to registered users (Must be Registered permission). Javelin readers cannot view Basic .DRM files

Although each “Basic” DRM document published can be read by anyone with a Drumlin PDF reader, when you create a "Basic" DRM file you may still apply controls such as No Print, Expire on a specified day, etc. which the end user cannot alter. As an alternative to this approach, you can produce a DRMX file and then use the Create exe option to turn this into a Javelin exe file, but one that does not require authorization (see exe files section, above)

If you wish to publish such files so that they can only be viewed by selected pre-registered Drumlin users you will need to use the UserLists facility (described later in this document).

File extensions and default settings

To select or un-select Drumlin or Javelin as your default PDF reader under Windows use the Windows File Explorer, select a PDF file and then right click with your mouse and select Open With... to pick the program you require. Then use the Choose Program... option to pick the program required and tick the “Always open with this program” option. This will re-assign PDF's to the selected program. If you have any problems with this facility please refer to the online FAQ page for more information.

If you cannot see file extensions such as .pdf, .doc and .drmx when in the Windows file explorer program, open any file folder (e.g. My Documents), select the Windows file explorer menu item Tools at the top of the window, and choose Folder Options... This will show a tabbed form. Select the View tab and see if the item “Hide extensions for known file types” is ticked. If it is, then un-tick this box and you will be able to view full file extensions in all your folders. An example for Windows XP systems is shown below:
Creating and Publishing Secure PDF files

Creating standard PDF files

For PDF generation we recommend use of Adobe’s commercial PDF creation tools (e.g. Adobe Acrobat Pro) or a product such as PDF Creator Plus (from Peernet Inc). The PDF creator in OpenOffice is also excellent and fast. Microsoft Office 2007 and later editions provide a Save As PDF facility (with various options for PDF creation). In many instances this will produce good files, but earlier versions can create files that leave lines and boxes on-screen and result in format errors. If this is the case with your files, use Adobe Acrobat X or later instead and the files will be OK. The use of form fields (e.g. buttons) as links and the use of transparency in images (see further, below), is not recommended as it may not work as expected. Javelin readers do not support form fields, buttons, or embedded content such as embedded video or audio in PDFs.

PDF files should be "transparency flattened" in most cases, otherwise they may not display correctly on all platforms. Adobe's help facility explains this as follows:

"When your artwork contains transparency, Acrobat performs a process called flattening before printing or saving the artwork. Flattening cuts apart transparent art to represent overlapping areas as discrete pieces that are either vector objects or rasterized areas. As artwork becomes more complex (mixing images, vectors, type, spot colors, overprinting, and so on), so does the flattening and its results. Flattening occurs whenever you print a document with transparent objects or export to a format other than Adobe PDF 1.4 (Acrobat 5.0 and later). Transparent objects are flattened according to the settings in the Advanced Print Setup dialog box. Flattening represents overlapping areas as either vector objects or rasterized areas."

If a PDF does exhibit problems (e.g. non-display or incorrect display of some pages) try using the flattening facilities in Adobe Acrobat (using the Tools menu, Print production facility for Flattening, or the Advanced menu, PDF Optimization option).

Another aspect of PDF files created using Adobe software is that they may include "Adobe-specific" features - indeed, many have suggested that PDF is not a standard document format at all, because it is really a huge collection of specifications and unspecified structures and attributes that really reflect Adobe's own product set rather some independently agreed international standard.

It is very important to note that some commercial PDF creation software and PDF writers produce very fragmented PDF files (e.g. with 20,000 image fragments for a single page) - with some PDF readers this may not be especially noticeable but for Drumlin and many other readers, good quality files are essential. If in doubt use the Adobe Acrobat software, as this definitely creates good files. If you have an existing poor PDF you can usually open it in Acrobat and then use the Reduce file size and/or PDF Optimizer options, or print it to the Adobe PDF printer using Standard settings to produce a very acceptable final PDF. If your files have open and/or owner passwords set using Adobe Acrobat or similar software, please remove this security before using Drumlin to create secured files. In general, security settings that are defined in the source PDF are ignored by Drumlin - we use our own encryption and security framework.

Files created using specialist publishing packages, such as Adobe InDesign, tend to produce very large "Print Quality" PDF files as standard. For electronic publishing select the option when creating the PDF (e.g. via the Export facility in InDesign) that generates small files [smallest file size], [screen display] etc, otherwise the resulting file may be very large and difficult to downsize. It is worth bearing in mind that most computer screens have a resolution of less than 100dpi, so creating very high resolution output is of limited benefit to those viewing the results. Modern portable devices may have screen resolutions greater than 200dpi. For text the screen resolution during output of a PDF is irrelevant as all text is displayed using scalable fonts, so should appear perfect or near perfect at all resolutions.

**File size:** we recommend files that are no larger than 50Mbytes and no longer than 2000 pages. Publishers with larger files are advised to use the standard Adobe Acrobat 'reduce file size' options and/or optimization options if they have larger files than this, and/or to split these very large files into smaller sections using either Adobe Acrobat or one of the widely available PDF Splitter programs (e.g. http://www.a-pdf.com/split/). Similarly,
publishers who are considering publishing files with >2000 pages may wish to consider splitting these for speed and manageability, depending on their content and experience having tested them using Javelin on the target platforms.

**Navigation:** we recommend that electronic (PDF) files targeted for screen-only display have some form of enhanced navigation included. Examples include: A navigation tree (also referred to as a Bookmarks tree by Adobe, or an Outline by Apple) this provides quick links to sections of the document via a tree-like panel to one side of the displayed document (for laptops and desktops) or via a CONTENTS button (for mobile devices); a Contents page, with individual section hyperlinked to the relevant part of the document; within-document hyperlinks, enabling users to navigate quickly to a related section and/or to the Contents page; and external hyperlinks, enabling users to access additional material on the internet.

**Creating Secure PDF files: UserIDs and DocIDs**

**UserIDs:** When you register a copy of Drumlin our server assigns you a unique userID. When you publish a secure PDF your userID forms part of the information about that particular secure PDF (collectively such information is known as the file “metadata”). Your userID is provided to you by email when you register and can be seen at any time via the Drumlin Help menu, About form. In the example below the userID is the last part of the registration code, i.e. 404 in this case. This information is important, because the system recognizes that a PDF file called “myfile.pdf” published by userID 404 is DIFFERENT from a file with the same name but published by a different user, say userID 2079. Notice that this form also shows your username, the name you used when registering. This information was confirmed to you at the time of registration but is always accessible here.

**DocIDs** are assigned to newly published secure PDF files. DocIDs, like userIDs, are also unique. If userID 404 publishes a file myfile.pdf it may be assigned a DocID of 23901, whereas if userID 2079 does the same thing a moment later they will be assigned a different DocID. For this reason it is important that when you order authorization codes or ask for code resetting you ensure you include your user details as well as the document details (name and DocID), thus avoiding any confusion. You can always view your docIDs, names etc. using the Drumlin software Tools menu, Document history.

If you re-publish a secure PDF to create an updated version of an existing DRMX or DRMZ file, the DocID will be unchanged as long as (a) the source PDF filename you use is unchanged, only the content is changed, and (b) you do not click on the option to "Keep previous version” It is always best to try and keep the same DocIDs if you require authorization codes, because each code issued is specific to a unique DocID - existing issued codes will continue to work and you will not have to order new codes. Drumlin Javelin "Click and Go" exe files are created from DRMX files (have the DRMX file embedded in them) so use the same DocID as the source DRMX file. If necessary/on request, we can re-assign authorization codes that you have generated or requested, so that unused codes will work on a different document (e.g. an updated version of an original document, but which has a different docID).
When a DRMX or DRMZ file or exe file is being authorized by an end user, and when it is being viewed, the DocID information is provided on screen. Within the Javelin reader for Windows this information together with additional details is provided via the Help menu, About form. In Javelin for Mac this is provided via the Properties form, DRM settings. On the iPAD and Android devices this is accessed via the Information button adjacent to the file, DRM Settings tab.

**Obtaining additional authorization codes**

For details on authorization of Drumlin’s secured PDFs see the Authorization section. To obtain additional authorization codes order these via the Store page: [http://www.drumlinsecurity.com/store.html](http://www.drumlinsecurity.com/store.html)

Email info@drumlinsecurity.com specifying the document or documents for which you require authorization codes and your UserID (if in doubt, this is provided in your registration email and on the Help menu, About... form). For DRMX or DRMZ and EXE files your authorization codes will then be sent to you as a text list by email. For DRMZ files 9 alphanumeric codes are used, for example: abc123def, whereas for DRMX files 20 character codes are used, e.g.: Code: 6WxZSdPng8aD4SdufKuf

On request these codes can be sent to you as an email attachment in the form of a secure .DRMX file. Note that authorization codes will only be supplied directly to the document publisher using the email address provided at the time of registration. Codes can be re-assigned by Drumlin Security on request from the publisher, and codes can be reset if necessary, again on request. For Subscription Service customers an AdminApp may be made available so that codes can be generated by the publisher without having to contact Drumlin Security Ltd.
Technical support

Drumlin Technical support can be contacted by sending an email to: support@drumlinsecurity.com - we aim to always respond to you within 8 hours during the working week, UK time, but often much faster. If your question is concerned with functionality (existing or possible enhancements) or is related to usage of our products and services, please email info@drumlinsecurity.com. Technical support on an ad hoc basis is provided free of charge, but for larger customers requesting extensive support a monthly service fee to cover the time involved may be required.

With technical problems we may ask you to send us a log file, as Drumlin software creates a number of such files in order to trace any problems. With the main Drumlin reader/publisher software you can do this automatically by starting Drumlin, selecting the Help menu, About... form and pressing the SEND LOG FILE button (see below). This creates a basic email message with two files attached, settings.cfg and drumlin.log - these are your current configuration file and event log file respectively. Add any additional text to the message you wish, and the send it to us.

With the Javelin software only the current active session is logged, as the program does not write to disk unless explicitly asked to do so. In this case go to the File menu, Log file option, and save the log file to a convenient location. Then attach this file to an email that you send to support@drumlinsecurity.com as before. If the Log File option is not displayed (Javelin for Windows version), go to the Help menu, About form and tick the box marked "Show extra menu items", and then return to the File menu and the Log file option should be available. Mobile versions of Javelin do not provide this feature, but do include logging for our own tech support purposes.
Tailoring Drumlin

The Drumlin reader/publisher client can be tailored and/or different implementations of the standard service provided. Modifications to the Javelin readers are made programatically, so please ask us for a quote to provide a bespoke version of the software. The Branding section provides more details.

Language files

Drumlin's menus, dialog and messages used in the software are all external to the program and are read from .xml files in the \languages subdirectory. These files may be edited if required in order to create a tailored version of the contents and/or to add a language not currently available. The settings.cfg file (see below) must include the list of available language names in order for these to be selectable.

Settings.cfg file

The settings.cfg file (a text file that can be edited) is found in the C:\Documents and Settings\<username>\Application Data\Drumlin Security\Drumlin directory (pre Win7)
or for Win7 onwards in the directory:
C:\Users\<username>\AppData\Roaming\DrumlinSecurity\Drumlin
and can be amended as follows:

This file includes a number of settings that control how the Drumlin program operates. Amongst these settings are the following flags (0/1 setting):

- "MustRegister" hides "Authorize document" and "Publish document" menu items, but only if the user is not already registered. Once registered these flags have no affect on the display.
- "ShowDownload" hides the "download" menu item. If enabled the File menu includes an extra item, Download... When selected the software contacts the server to see if there are any centrally stored documents available for download to this registered user. Note that this facility is only available as part of an Enterprise Server implementation and requires the use of an additional program, the Drumlin Administrator, which provides facilities for uploading documents to the server and for enabling specific users to download selected documents. Downloaded documents are saved as .DRM files and are immediately readable.
- "ShowOptions" hides/enables "Options" menu. This is purely provided for screen display quality optimization - the preset choices should be the optimum for most modern computers so the menu item is generally not required.
- "ShowRegCode" hides/enables "Reg code" edit box in registration form. Only relevant for first registrations if registration IDs have been provided in advance of users installing Drumlin. If pre-set to show the Reg Code box, the user simply enters this code in the box shown and the system assigns them this ID. If Download is also enabled then one or more centrally stored documents can be made immediately available for download to all newly registering users.
- "ShowWelcome" hides/enables the display of the Welcome file when the software is first run. Note that for corporate clients a bespoke Welcome can be included in specially generated installation kits.
- "DontOpenLastDoc" prevents Drumlin from displaying the last file you looked at if set to Yes.

There are also several other settings, some of which are updated by the program (e.g. preferred window size on startup, preferred source directory for documents to be published, and preferred destination directory for authorized documents). There are also several URLs which the program uses when looking up where documents are published (i.e. the server that hosts the DRM data and optionally uploaded files) and where online help is to be
The registration form can be tailored to make certain fields mandatory. To implement this facility a "RegFields" entry must be added to the settings.cfg file, for example:

<RegFields>81</RegFields>

The number shown is a bitmask with following values:

ADDRESS1_F = 1; ADDRESS2_F = 2; ADDRESS3_F = 4; POSTCODE_F = 8; TOWN_F = 16; REGION_F = 32; COUNTRY_F = 64; ORGANISATION_F = 128; TEL_F = 256; FAX_F = 512; MOBILE_F = 1024; EMAIL2_F = 2048; WEB_F = 4096;

So, if you, for example, want to select Address1, Town and Country, your number will be: 1 + 16 + 64 = 81

Background bitmap

Corporate specific background logos/text can be provided on request - an image file (e.g. a tif file) is required and a modified version of the background.bin file included in the Drumlin reader directory in then generated and can be included in bespoke kits. A stand-alone program for creating the required files is available.
Part II

Using the Drumlin PDF Reader
Using the Drumlin PDF Reader

Simply use the main Drumlin reader software as you would your standard PDF reader. Use the File menu, Open option to open PDF files and/or Drumlin's secured PDF files (which have the extension .DRM or .DRMX). To authorize a DRMX file when prompted, see the authorization section, below. To authorize an EXE file or a DRMX file using Javelin please see the "Javelin" reader user guides. Note that the iPad/Android compatible DRMZ files cannot be opened by Drumlin - these can only be opened using Javelin readers (for iPad, Android, PC and Mac OSX).

With the Drumlin Reader software use the Tools menu, Language option, to select your preferred language (e.g. French, German, Spanish, etc.); explore the toolbar and menu items to see the various facilities provided – a full list of these functions is provided later in this document. Open any .PDF or secured .PDF (this will have the additional extension, .DRM) to view and print documents. Use the File menu, Publish New Document option to create your own, fully secured PDFs.

The Drumlin reader supports document viewing, printing, searching, and navigation aids including Bookmarks and hyperlinks (if supported in the source PDF) as illustrated below:

Although PDF forms will be displayed, form field processing is not supported, nor are embedded or attached files or Javascript. Multimedia files embedded in PDF's cannot be played, but may be accessed via links which could be a screen shot with a 'click here to play' icon and/or text. External application linkage is supported in Version 6, so an external file such as an avi file, flash file or Excel spreadsheet can be invoked using an explicit file link within the PDF. Keyword search support is provided. Copying of sections of text may or may not be permitted, depending on the settings applied. Note that the Drumlin reader always disables the PrintScreen function under Windows whenever it is run. If you wish to capture sample Drumlin screens (e.g. to produce sample documentation) then use a screen capture program or facility, e.g. using Paint Shop Pro (PSP). Likewise, in Javelin, make sure that the file you create (if secured) does not have Screen Capture disabled (when the DRMX file is produced) otherwise it will prevent you from capturing screens, even using software like PSP.
• DRM files: The Drumlin reader supports basic viewing and printing functions for Drumlin secured PDF documents (.DRM files) and for conventional PDF files. There are two types of DRM file: locally generated DRM files, which have restrictions on the number of times they can be viewed and which may not be printed (in the standard edition); and fully secured DRM files that are created by authorizing a DRMX file (see below). These latter files, and their authorized versions (authorized DRM files) are extremely secure and if copied between computers the copy cannot be viewed.

• DRMX files: these are fully secured (encrypted) PDF files that are awaiting authorization. Use the File menu, Authorize... facility to turn these into a DRM file using the authorization code provided to you by the document owner/publisher. The Javelin reader can also authorize DRMX files via its File menu, Open... option. IMPORTANT NOTE: Drumlin V6 creates a new format of DRMX file that is not compatible with the version 5 release. This has been necessary in order to provide platform independence of the DRMX files. Drumlin V6 can open V5 and V6 version files and can write V6 version files only. The Javelin reader can only open V6 DRMX files, not version 5 files - attempting to open a V5 file will result in a warning message. Publishers with existing DRMX files that they wish to publish as exe or DRMX files for Javelin will need to re-generate the DRMX files first.

• DRMZ files: these are essentially the same basic format as DRMX files but with a different security mechanism. When a DRMZ file is generated using Drumlin it can utilize the same source PDF for its creation, with the result that it will have the same docID as a file generated in DRMX format from the same pdf. This process will not result in any change to the document record in the database.

• EXE files: these are DRMX files combined with a stand-alone reader into a single executable. Typically these files will require authorization - EXE files are a "Javelin click and go" solution (Windows version only).

• Embedded links and bookmarks: Drumlin supports embedded links and bookmarks if these have been created correctly in the source PDF. Embedded links that are actually form fields are not supported - standard links should be provided at all times. Such links may be to locations within the PDF or external (i.e. hypertext links to websites).

• External application invocation: Drumlin and Javelin for Windows can invoke external applications using hyperlinks to local files rather than traditional hyperlinks. In the case of Drumlin the preferred settings form allows you to specify whether you allow such links or not.

• Copying: Copying of text is disabled as standard on secured files, but may (optionally) be enabled by the publisher. It is enabled for standard PDFs. Within Javelin text copying is always disabled.

• Printing may be enabled and/or restricted (e.g. number of times or pages that may be printed) depending on the publisher's settings for this document. See the Printing section for more details. Printing is not provided for iPad/Android users.

• Page selection: The View menu and the page selection toolbar facilities enable you to select specific pages and/or go to a specific page as does the Bookmarks tab (if provided). You can also use the mouse wheel to scroll and PgUp, PgDn and arrow keys to move around a document.

• Publishing secure, encrypted PDFs: You can publish an existing PDF file to the encrypted DRMX or DRMZ formats with security controls that you specify. You must be online and registered with the service to use this facility. DRMX and DRMZ files may be freely distributed and are not readable until authorized using a valid authorization code to enable them. You can also publish locally generated DRM files (see above) without the need for authorization codes - in order to read these latter files Drumlin rather than Javelin is required. Special arrangements are available for users or organizations wishing to publish locally generated DRM files with unlimited views and/or printing permitted, or to generate such files for pre-registered users without the need to subsequently have these authorized.
Navigation

Drumlin includes several facilities to aid fast navigation around PDF files. These include the various view and search facilities described above, together with support for internal and external hypertext jumps HYPERLINKs, if the document author has generated such links in the source PDF and browsing via browser buttons (the green back and forward arrows).

Toolbar

The facilities provided via the standard Drumlin reader toolbar are shown below. Many of the functions are also provided via menu items (additional facilities may be provided via the File, View and other menus, depending on the version and setup of the Drumlin software you have installed):
<table>
<thead>
<tr>
<th>Toolbar Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open an existing file (File</td>
</tr>
<tr>
<td></td>
<td>Print – if enabled. Printing may be limited to a certain number of copies or pages (File</td>
</tr>
<tr>
<td></td>
<td>Email a Drumlin readable file: attaches file to a New Mail item using your email client</td>
</tr>
<tr>
<td></td>
<td>Drag: pages may be dragged by holding the left mouse button down or using the mouse wheel</td>
</tr>
<tr>
<td></td>
<td>Select text by area: if enabled</td>
</tr>
<tr>
<td></td>
<td>Search: free text search of entire document, single words or strings (View</td>
</tr>
<tr>
<td></td>
<td>Go to first page (View</td>
</tr>
<tr>
<td></td>
<td>Go to previous page (View</td>
</tr>
<tr>
<td>1/24</td>
<td>Shows current page/pages: type in box and press Enter key to go to a page (View</td>
</tr>
<tr>
<td></td>
<td>Go to next page (View</td>
</tr>
<tr>
<td></td>
<td>Go to last page (View</td>
</tr>
<tr>
<td></td>
<td>Fit page</td>
</tr>
<tr>
<td></td>
<td>Fit page width</td>
</tr>
<tr>
<td></td>
<td>Zoom in: fixed zoom in (View</td>
</tr>
<tr>
<td></td>
<td>Zoom out: fixed zoom out (View</td>
</tr>
<tr>
<td>0% 100%</td>
<td>Zoom factor (select from drop down or type in value required)</td>
</tr>
<tr>
<td></td>
<td>View single pages</td>
</tr>
<tr>
<td></td>
<td>View facing pages (currently not enabled)</td>
</tr>
<tr>
<td></td>
<td>Rotate clockwise</td>
</tr>
<tr>
<td></td>
<td>Rotate counter-clockwise</td>
</tr>
<tr>
<td></td>
<td>View/hide Full Screen mode (press Esc or use the View menu, full screen option to exit mode). In Javelin this is implemented in a similar manner to that provided in Adobe’s reader, i.e. for support of presentation devices</td>
</tr>
<tr>
<td></td>
<td>View/hide Sidebar showing navigation and bookmarks frame</td>
</tr>
<tr>
<td></td>
<td>Add, Edit and Delete bookmarking of pages</td>
</tr>
</tbody>
</table>
Browser buttons

In addition, to the left of the toolbar, are two browser buttons:

These enable you to navigate backwards and forwards through the document, reflecting your history of page display. For example, if you click on a link within a page that takes you somewhere else in the document, you can press the BACK button to return to where you were. This is essentially the same as the mechanism used by web browsers.

Document contents table

If a PDF includes a document structure section (e.g. generated from a document Contents table) this will automatically be displayed in a re-sizable window on the left of the viewing screen, as shown below.

Zooming

Tools are also provided to enable you to zoom in or out at any point – these are accessible via the toolbar icons, View menu and by right mouse (or “in context”) clicking on any page in the document. Other basic functions are also provided via the in-context right mouse button click a Bookmarks... option is now also included, which is described later in this document):
Copying to clipboard

When copying to clipboard is permitted and the area/text selection toolbar icon (T) is pressed the in-context menu includes select and copy facilities. So, to select text press the icon shown below, then drag a rectangle over the area to be selected.

The result will look something like the following:

The highlighted area is the text that will be selected. The in-context menu (right mouse click) shown includes the Copy and Select items.
Authorizing DRMX files using Drumlin

Use the Drumlin file menu, Authorize option, to select a DRMX file for authorization (see further, below). DRMX (and DRMZ) files can be authorized using the separate Javelin PDF readers, via the File menu, Open... and (where necessary) re-authorize options.

Once authorized the file will not generally require authorization again in the future. However, if you do try and re-authorize a DRMX file the software will ask you if you really want to do this, or simply use the existing authorized file. Authorization involves entering (or Paste-ing in) a 20 character text string, which is checked against a list of available and valid strings for that document and (optionally) that individual (registered copy of Drumlin). This check is performed on our DRM server and if OK, then with Drumlin a new file is generated (with the extension .DRM) and it is this file that you will open in future. With Javelin an authorized DRMX file remains the file that is opened subsequently (i.e. a separate .DRM is not created).

File properties - security information

The Drumlin software is designed to open and display (view) and optionally print standard PDF files and special PDF files that have been converted by the document publisher/owner to either the secure .DRM or .DRMX formats. If you register your copy of the Drumlin software you can publish secure PDF documents yourself. To view the General (PDF) or special (DRM) properties of this file use the File menu, Properties option, appropriate tab and you will see the following information (or similar):

The .DRM and .DRMX file formats are strongly encrypted versions of PDFs with built-in permissioning and digital rights management. Essentially this means that when you receive or download a .DRM or .DRMX document it will include controls that determine whether you can simply view the document (possibly for a certain period or number of occasions), and/or whether you can also print it, copy it etc. The publisher/owner sets these attributes. Details of how to do this yourself are provided later in this document. To view a standard .PDF file or a .DRM file simply open the file with the Drumlin program. DRMZ files are a variant of DRMX files that are designed for cross-platform usage using the Javelin PDF readers. They can be created by Drumlin but are not readable using Drumlin.
Manually entering an authorization code

If you have purchased or been supplied with a Drumlin .DRMX file you must first obtain an authorization code from the owner/publisher to authorize this so you have a document you can read. This is carried out using the Drumlin program’s File menu, Authorize… option to convert this file to a .DRM file, which is then readable on your PC (this file cannot be authorized again without a new code from the publisher, nor can it be copied to and viewed on another computer once authorized). You must be connected to the Internet when authorizing files. The Javelin reader can also be used, in a similar manner, to authorize DRMX files (or DRMZ files) for use within that reader, and for most situations using Javelin is the recommended option.

When the Authorization Code Entry form is displayed enter the Code you have been supplied with – you can copy this Code to the Clipboard and then Paste it using the Clipboard button (see below) or your mouse button (right click) or Ctrl+v into the field shown. If all is OK the file will be unlocked and saved, and then opened for you to view:

```
Authorization Code Entry

Please enter authorization code for document.

Document Name: StatsField.drm
Authorization Code: [Redacted]...

OK Cancel
```

It may also be a requirement (set by the owner/publisher) that you have an online connection to the service when you wish to read the document. This feature is specific to Drumlin and is not supported in Javelin readers currently. Please keep a copy of your authorization codes in case of any problems with your computer.

Automatically entered authorization codes

As noted above, authorization is made using an authorization code. This code can be paste-d into the authorization code field when prompted (e.g. when a DRMX file is opened or an EXE file is first run), or can be provided as a DAC file (a text file with extension .dac) in the same directory as the exe or drmx file. Drumlin or Javelin "Click and Go" readers will look for the DAC file and try and use this first, so the end user does not have to copy/paste the authorization code into the field. .dac file provision is optional.
Copying content

Drumlin automatically restricts the use of the Windows clipboard, print screen and (optionally) screen capture programs for certain documents. The restrictions apply to encrypted Drumlin documents that do not have the option "enable clipboard" selected, i.e. by default Drumlin documents have the clipboard disabled whereas for standard PDFs it is enabled. When secured documents are opened the Drumlin reader disables the Windows clipboard and the Windows Print Screen facilities.

If, in addition, the Disable Screen Capture option has been selected when the document was published then Drumlin also checks for the existence of screen capture programs that may be running (actively, or passively in the background). If Drumlin considers that such a program might be running it issues a warning message asking you to close the program in question before continuing. To close such programs, select the program (if it is open and running) and use its Exit option to close it. Some capture programs install an icon on the Windows toolbar and may not exit when the program is closed (see example, below). If this is the case, then select the icon in question, right click on it, and select Exit to close the program fully.

If Drumlin still detects a running capture program, and you have not been able to exit these in the way described, check the documentation for the program concerned to see how it should be closed. If all else fails you can run the Task Manager (e.g. press Alt+Ctrl+Del to start the task manager in most cases) and delete the process identified in the Drumlin message – make sure you have selected the correct process first! Users should contact Drumlin (info@drumlinsecurity.com) if they wish to request temporary enabling of screen capture, having provided a full explanation of why they require this facility.
Bookmarking

This feature within Drumlin enables any page in a document to be marked using the icon at the top right in the screen shot below, or by right clicking in the document and using the in-context menu, Bookmarks option. Bookmarked pages are highlighted with a yellow border and page number and text description (which can be edited) in a new Bookmarks tab (see below). The text in the bookmarks tab is automatically generated but can be edited. The bookmarking details are stored as a separate file in the same directory as the document file, but with a .bmk extension. If a file that has been bookmarked is moved or emailed the bookmarks will only be included if the corresponding .bmk is also moved/ emailed with the main document file. Javelin PDF readers provide such facilities in a different manner.
Language selection

The Drumlin software is multi-language enabled. English, German and French language files plus a number of others are provided with the initial installation. Select your preferred language via the Tools menu, Language option. Javelin for Windows provides a large number of language selection options, and in this case the language details form part of the program itself (rather than being in an external file).

Additional languages for Drumlin may be downloaded via the Tools menu, Download language files option.

Language files are editable XML files, so may be edited and/or new language files generated as required. The list of supported languages is specified in the Drumlin settings.cfg file. The standard entry is of the form:

```
<Language_0>English;English.xml</Language_0>
<Language_1>Deutsch;German.xml</Language_1>
<Language_2>Francais;French.xml</Language_2>
```

To include a new language, simply download (or create your own) language file and add an entry similar to those above to the .cfg file. The settings.cfg file all specifies the default language to display, e.g.:

```
<DefaultLanguage>2</DefaultLanguage>
```

The settings.cfg file (a text file that can be edited) is typically found in the Application directory, e.g.:

```
C:\Documents and Settings\<username>\Application Data\DrumlinSecurity\Drumlin
```

You may need to include these entries in the settings.cfg file in your Drumlin program directory also.

Language files should be saved to your "\Drumlin Security\Drumlin Reader" program directory, \Languagesubdirectory. Each file is in XML format and can be edited with a text editor such as Notepad.

Language selection is also provided within the Javelin reader, but in this case the text is embedded within the reader. See also the Javelin reader settings (command line options) for the Windows version of Javelin.
Preferred settings selection

Drumlin stores information locally as well as on the Drumlin server. Information on the server relates to users, documents and authorization, but not the documents themselves (unless stored centrally as part of an Enterprise Content Server solution). Locally stored information is kept in a number of files that include the current settings selected that control how Drumlin displays information etc., and logged information, for tracking any problems, and for recording the Drumlin activity and publishing history (see Keeping track, for more details).

For preference settings many of the features operate automatically, i.e. they recall the settings made during the previous usage of the software. Others can be set within parts of the program: (a) using the Tools menu, Settings.. option; (b) Using the Save settings option in the Publish New Document form.

Tools menu, settings

The settings option on the tools menu includes facilities for specifying (i) the location of the web service that your copy of Drumlin is using - in general leave this unaltered! (ii) whether or not you wish Drumlin to open the last document you viewed; (iii) the resampling method selector allows you to select one of 10+ different algorithms for image re-sizing (or resampling). The default setting is Bresenham, an algorithm that delivers good results over a wide range of zoom scales, including size reduction. Better scaling can be achieved with some algorithms, such as Mitchell, but this may result in linear artifacts showing on screen.

![Settings dialog box]

Users of the Javelin for Windows reader can manually change resampling method (from the default value=6/Bresenham) by starting Javelin.exe or any CaG.exe file with a command line switch of the form:

filename.exe -R12 or filename.exe -r5

The -R switch permanently sets resampling method (writes it to the registry) whereas the -r switch uses the set method only for the current session - see the Javelin command line options for more details.

The External application drop-down is set to Always allow in the screenshot above, but can be changed to Never allow or Ask user. An external application link can invoke any external application or file, for example to run an animation, display a 3D model or view a spreadsheet.

Settings.cfg file

Most settings are stored in the settings.cfg file (see further, Tailoring Drumlin), which may be accessed and edited directly using a text editor such as Notepad or Notepad++ if necessary. The file is formatted in XML style.
and is usually in a directory of the form:

C:\Documents and Settings\<PC username>\Application Data\DrumlinSecurity\Drumlin

This information can be accessed automatically via the Help menu, About form, where a Send button is provided to the settings and log files can be emailed to our support desk if required.
Printing

Printing may or may not be enabled for your secured PDF, and if enabled may be subject to restrictions. The core details of the settings are provided on the File menu, Properties option (DRM tab).

If printing is enabled it will be provided via the File menu, Print... option or by using the Print button on the toolbar. This provides a standard print dialog of the form shown below. As with other Windows applications, specify the printer you wish to use, defining the preferences for that printer where appropriate, and select the page range and number of copies required from the fields provided.

Important notes:

- Printing, if permitted, is to physical devices such as a locally attached LaserJet or Inkjet device. Printing to non-physical devices (files, image-writers, print sharing software devices or PDF writers) is disabled using one of two algorithms to detect such devices (computers and mobile devices do not provide a distinction between physical and non-physical printers). The standard algorithm is very strict and may prevent some genuine devices from being used, whereas the relaxed option allows such devices but is (by definition) not as strict (see below). Printing may or may not be enabled to Network Print devices - and only such devices as are recognized by the software.

- If printing is enabled an additional option selector, “Relaxed printing” is available. This setting uses a less strict algorithm than our standard print control software when attempting to determine whether a print device is a valid physical printer or a non-physical device such as a PDF creation utility. If the Relaxed printing option is selected and printing enabled then documents can be successfully printed to a wide range of semi-virtual print facilities, such as wirelessly connected HP printers and in-network software services that provide print functionality.
• Printing may be limited to a set number of times or may be permitted an unlimited number of times. There may also be a separate limit on the number of pages that may be printed, so if the print count is unlimited (set to -1) but the page count is 100, say, you can print a total of 100 pages, either as a set of 100 one page prints, or as two 50 pages prints, etc. To set a page count limit it is best to specify the number of times the file can be printed to -1 (which means unlimited) but the number of pages to the value you require, e.g. 50. If you set either of these values to 0 the file cannot be printed.

• By default printing will be centered and not re-scaled but see further below on print scaling

• The "number of copies" field is generally ignored when printing secured PDF files

• Print scaling: In the Javelin reader for Windows an extra print tab showing "Printing scale" is available, printing precisely to scale is possible. In the example below printing is selected as "No scaling" against the alternatives "Best fit to page" and "Stretch fit to page". By choosing No scaling the exact dimensions of the source file will be respected - in the example shown below, for a sewing pattern that has been tiled to fit on US Letter paper, selecting No scaling ensures that even if printed on a different paper size (e.g. European A4) the dimensions of the pattern are preserved.
Part III

Secure PDF Publishing
Secure PDF Publishing

The Drumlin software may be used to convert your own PDF files to the secured .DRM and .DRMX or DRMZ formats, for subsequent distribution and optional sale/rental of the copies provided. This is achieved using the File menu, Publish, Publish Documents. option. In addition a DRMX file may be used to create a Javelin "Click and Go" EXE file using the File menu, Publish>Create EXE option. When used with Drumlin an authorized DRMX file includes the PC's WindowsID, DiskID and UserID into the encryption process. With standard versions of Javelin the UserID is not included as there is no user registration process. However, in both cases the authorized PDF is effectively locked to the device on which it was authorized and the disk used - authorizing a document on a removable drive and taking this to another device will generate a request on the second machine for the file to be authorized separately for that machine. For most applications we now recommend that publishers opt for the .DRMZ format. This is simpler, can be used on all supported technology platforms, and can be re-published as often as required without risk of the encryption system becoming out of synch (see further, Document type).

The number of different secure files you can create is limited by quotas - with a basic initial quota of 100 publishing events being provided without charge. When the initial free quota is used up a message is issued by the software and you will need to contact us for additional quota. Larger quotas are included for subscription service customers so the limitations described above should not apply. Quotas are also applied to the number of codes that a subscriber can generate using AdminApp (overall and per document at one time), the number of code resets such publishers can make, and the number of free test codes supplied when a PDF is converted to secure format.

To use the Drumlin secure publishing facility you must first register your copy of the Drumlin software. Then select the menu option, File and then Publish Documents… to view the publishing screen. Each tab is described on the pages that follow.

When you have completed your selections of document type, permissions and any watermarking you wish to add first SAVE SETTINGS and then select the OK button at the bottom of the Publish New Document form:

When the OK button is pressed details relating to your document (but not the document) are sent to the central Drumlin DRM server and held on file within an SQL database.

If you have created a single secure file using Drumlin an authorization code is provided automatically (for testing, with usage count set to 5) or you can request test codes from Drumlin Security.

If you have selected multiple documents to publish then each one is created in turn and test authorization codes are not generated. Authorization codes for testing and production usage are typically created using the AdminApp program. As each file is generated and data exchanged with the central server, the white bar above will show a blue progress bar. Typically publication of each document only takes a second or two (see also, Keeping track of your documents,).

The buttons on this lower section of the form include:

Help: this goes to our website for help on publishing pdf files

Save settings: this saves your permissions settings for DRM and DRMX or DRMZ files for future use as the defaults to be used - you can press Save settings at any time

Batch publish: this button only appears if you have been enabled for it by our support team. It provides the
ability to select very large numbers of documents across multiple directories and subdirectories, for inclusion in multiple secure publication of these files

**OK**: initiate creation of a new DRM or DRMX or DRMZ file, or set of files - if a set of files has been selected then each file will have the same security settings applied to them when created

**Cancel**: exit the Publish Documents form
Document info tab

Use the drop down menu or the [...] button to select the file (or files) you wish to publish in secured form. You can select multiple files in the normal manner for lists (using the Ctrl and/or SHIFT keys whilst selecting from a list). Each file you publish in secure form remains on your own PC and your source pdf file is unaffected. You can provide a text description of the document, plus a version identifier and optional ISBN (for books).

The Keep Previous Versions selector should only be ticked if you want to use exactly the same file name and description, and version number of your document, but do not want to overwrite the entry for this document on the central database. If this box is ticked a new record (and new DocumentID) will be created for this publication on the server. Typically we would recommend that it is better to leave the box un-ticked and give the document a new name (e.g. myfile_new).

If you have a very large number of files to securely publish, especially on a regular basis, then use of the Batch option is recommended.
Document type tab

The second tab on the form identifies the type of secure document you wish to create. This can be a fully secured DRMX file or a basic DRM file. If a DRMX file is selected and the Generate file for iPAD/Android box is ticked, the generated file is saved with file extension .DRMZ (see below):

To generate a fully secured document select the “Generate fully secured DRMX file” option, and then specify the Permission options and dates you require using the Permissions tab (see below). DRMX files provide the strongest security protection but cannot be read on iPAD and Android devices. An end user requires an authorization code from you, the publisher, to open a DRMX file and generate a readable file. This process encodes the user’s identity and their computer’s identity into the generated file (in the case of Drumlin), so only that user on that PC or Mac can read the file. In the case of Javelin the process is slightly different, as users are not registered, but the result is similar - the file is just authorized for that specific computer or device.

Note: If you create a DRMX file (not a DRMZ file) a new random encryption key is created for each publication event. Thus every created document is in a sense “uniquely” encrypted. The encryption process stores part of the key on the server and part within the file itself, so the file can only be authorized if the two parts match. In most cases this does not affect the publishing process, but if a file is created and distributed, and then the same file is re-generated and the version made available for distribution is not updated with this new version, the
encryption components will not match and file authorization will fail. The solution to this issue is to ensure that distributed versions of files are always of the latest version, are authorized in synch with the version, or by creating DRMZ files (which do not have this split key structure), or by creating a DRMX with a new version name each time (and hence new DocumentID). New files will, in general, require new authorization codes (if the DocumentID for the file has changed).

A DRMX file with the iPAD/Android tick box selected creates a DRMZ file. This format is required for iPAD and Android usage and is also readable by Javelin for Windows and Javelin for Max OSX - thus DRMZ files provide cross-platform operation and are recommended for all but the highest security requirements.

The second type of secured file you can generate is called a "basic DRM" file. This is also an encrypted file, and can include security controls, like expiry date and printing restrictions. However, basic DRMs can be read by unregistered users so are useful if you want to make a document available to anyone who installs Drumlin, with no need for authorization. Basic DRMs can also be restricted so that only a specified list of registered Drumlin users can open them. This requires the userlist option to be selected, and the list of userIDs of these users to be included when the document is published (see userlist section later in this document, for more details). User lists are ideal for intra-corporate document distribution and for computer rooms (e.g. training centers) as it is a simple and secure way to control these documents, with no need for the authorization process.
Document permissions tab

This is the tab you use to set the various permission controls you require. The NO LIMITS button automatically sets the View#, Print# and PrintPages# to -1, which means unlimited, i.e. no limits on the number of times. The Disable printing option selector disables printing and grays out the Print# and Print Pages# fields. Note that Print settings do not apply for iPAD and Android devices as printing is not supported on these devices.

Date controls: Start and end dates/Expires after

These are self explanatory, but in addition to the specified dates, the “expires after” option allows you to specify that a document can be read for 2 days (for example) and then it will expire. This is effectively a form of document loan or rental, or simply a means of allowing an end user a fixed amount of time to review the file. A file that has expired as a result of an “Expires after nnn days” can be renewed simply by provision of a new, or re-enabled, authorization code for that file. Files that have an absolute expiry date cannot be re-enabled - a new file must be issued with a later expiry date.

IMPORTANT NOTE: The main Drumlin reader and the Javelin readers incorporate a number of checks to ensure that the system date on the end user PC has not been tampered with (e.g. set back and then reset forwards).
Making such changes could disable your use of one or all of your secured PDF files!

**View#**

Set to -1 for unlimited viewing. Set to a number, e.g. 2, to permit viewing 2 times. Can be reset by re-authorizing a file after the available count has been used up.

**Print#**

To disable all printing set to 0 or select the option selector **Disable printing**. Set to -1 for unlimited printing (subject to the page count setting, PrintPages). Set to a number, e.g. 2, to permit printing 2 times. Note that if a user opted to print on two occasions and only printed the ‘current page’ each time, they will no longer be able to print any more pages. The alternative is to set Print#=-1 and then add a PrintPages# entry (e.g. for the total number of pages in your document, or twice that number to allow for the whole document to be printed twice). See Printing for more details.

Note that if you have a PDF whose page size is very large (e.g. much larger than standard printers support, which is generally US Letter or A4) then you can use a program like Adobe Acrobat to convert the large page into "tiles" that match your preferred print page size. The result is a multipage version of the original page which can be printed and then re-assembled to produce the same result as a large page. A guide diagram as to how to re-assemble the pages correctly may be advisable, and printing of such pages will generally use the "No Scaling" option in the PDF viewer to avoid any re-scaling of the final result.

**PrintPages#**

This option only applies if Print# is not set to 0 or disabled. It specifies the number of pages that may be printed overall (i.e. across all sessions of printing that are permitted). See Printing for more details. If specified we recommend setting the Print# value to -1 (unlimited) and the PrintPages# to the number of pages you permit to be printed.

**Relaxed printing**

This is an option selector that applies when printing has been selected and a less-strict algorithm is required. Choose this option if you want to be certain that the document will print on almost every possible print device. See Printing for more details.

**Network printing enabled**

This option only applies if Print# is not set to 0. It permits printing to network printing devices as well as locally connected devices. See Printing for more details.

**Clipboard and screen capture**

Typically copying to the clipboard is disabled as the default, and likewise, use of screen grabbing programs is disabled. Currently we recommend that screen capture disabling is not used as a standard option, as it can cause additional support issues when users find they cannot view documents because some background process initiated at system startup is running and prevents the reader from working unless this process is closed. For additional protection use of Intelligent Watermarking is recommended.

Note that screen capture protection applies only to the Windows version of Javelin, and is provided as a limited form of protection against this kind of operation, which is widespread on PCs. Screen capture protection is not provided in the Mac reader or for iPADs or Android devices (in the latter case screen capture is often built into the hardware so cannot be disabled).

**Must be online**

If you select the “Must be online” option the user must have an online connection to the Internet when they try and open the document, but not throughout the time they are using it. This option, which is only checked when Drumlin is the reader software, checks the central server to see that the document details are valid, including the
date range against the server’s own clock, and will prevent access if necessary even if the user has altered their own computer’s clock. Then make sure you are online and press OK as before. Currently the "must be online" control is not supported for Javelin readers.

**Must be registered**

This option is grey-ed out unless you are creating a Basic DRM file. For most applications the option is not used. It requires that a person wishing to read a Basic DRM file must have registered their copy of Drumlin, which would be the case normally for all Drumlin users.

**Watermarking**

Watermark tab: the use of this facility is described later in this document. It enables a watermark to be printed on every page of a document for which you have allowed printing, with the content of the watermark to be dynamically created from a template you provide. This template includes your text plus field-based data, such as the user’s name and the PC ID, which are added when the file is printed, and cannot be removed. Watermarks can also be placed on screen, which is recommended for mobile device usage.

**Password**

An "open" password can be defined. This is a fixed password, encrypted within the file, that prevents the file from being read by anyone with access to the computer in question and thus to an authorized secure file - i.e. the user must enter the password in order to read the file, even if it has already been authorized. This feature applies to Drumlin and Javelin for Windows/JavelinPro for Windows only at present. If in doubt, leave blank!

**Document properties**

You can use the File menu, Properties option to see the settings made for the currently active document.
Document watermarking tab

This facility enables an "intelligent watermark" to be displayed on every screen and/or printed on every page of a document. Initially you select whether you want a watermark to be include for one or both cases, and then define the attributes of the watermark to be included. Watermarks of this type are handled differently for on-screen and print operations so please read the information below carefully and then experiment with options to obtain the results you are seeking using the Define watermark button:

The content of the watermark is created dynamically from a template you provide. This template includes your text plus field-based data, such as the user's name and the device ID, which are added when the file is printed or viewed, and cannot be removed. Intelligent watermarking ensures that screen displays and printed documents include a watermark that identifies who displayed and/or printed the document and when, providing traceability and accountability.

The screen shot above illustrates the facilities available. Watermarks are placed on the diagonal by default, based on an origin that is the center of the page. Field data can be included, as shown, with the following interpretations:

%F filename  %M machine name  %C document ID
%U username  %I MachineID  %D date
%T time  %a authorization code used

© 2015 Drumlin Security Ltd
When watermarking is used and the planned distribution mechanism is via Javelin, there is no user registration so the %U field will not produce any information. As a general rule it is best to use the %a field, since this is trackable even where the end user has not registered, and optionally the %M or %I fields as this identifies the device used. Javelin suppresses the on-screen display of the middle characters of the authcode, in case its display reveals information about a valid code when multi-use codes are provided. The %U field is supported by Drumlin and by JavelinPro for Windows (where the latter has been registered).

With Javelin watermarks are currently always centered at the lower section of the display window, and for on-print are placed to reflect the positioning settings (vertical and horizontal offsets) - this is not a perfect process at present! In the latter case the font used to display the watermark is always an outline rather than solid font (opacity is not handled).

The Preview option provides a visual indication of the positioning, size and font on a blank page using the settings of the current default printer. Typically the watermark is placed across the printed text, thereby making its removal difficult or impossible. If required the watermark can be placed at the foot or top of each page, for example, so it does not overlap the text. For instance, with an A4 page, a horizontally aligned footer watermark can be generated by setting the angle to be 90 (rather than the 45 degree default) and the vertical offset at around 275mm (depending on where the text on your pages end).
Userlist facility

This facility extends the functionality of basic DRM files so that instead of being readable by anyone with the free Drumlin Reader software, they can only be read by a list of pre-registered Drumlin users. The userlist facility is a form of pre-authorization, removing the need for authorization of files by end users and avoiding the requirement for internet access on these machines - for example, for laptops used by engineers or sales staff in the field. It is also a convenient way of setting up a computer center (e.g. a computer training room) with files that are enabled for the registered machines, without the need to authorize every document on every machine. A different example would be for the distribution of a periodical to subscribers, for example a weekly or monthly newsletter or journal.

Each machine must be included within the userlist in order for it to be able to view the documents. A sample userlist window is shown below:

Once the function is enabled, a simple file called userlist.txt must be created and placed in your Drumlin program directory (i.e. where drumlin.exe is stored). Each entry should be of the form:

<userID>tab character<optional helpful text>

Once a file of this type is created, start Drumlin, select File|Publish New Document, choose basic DRM as the file type and select the User List option on the Document type tab. A list like that shown above is then displayed. You can then select from this list in the normal manner (single or multiple entries, holding down the Ctrl or Shift keys for multiple selections, as required). For publishers who wish to make extensive use of this facility there are additional batch publishing and other stand-alone software tools (DRMInfo, DRMEdit) available to make the process easier to manage. DRMEdit enables the userlist and expiry date for a previously published Basic DRM file (or files) to have userlist data and expiry information added or amended without the need to republish the files via Drumlin. For the latest version of Drumlin the DRMEdit program is run from the Drumlin reader program directory and prompts for one or more DRM files. Select the file or files to be amended and right click to make the changes required. For pre-version 6 files there is a slightly different version of DRMEdit. Please contact us for details.

Userlist enabled document creation is normally enabled when you install your copy of Drumlin, but you may need to request the facility to be enabled or re-enabled if it is turned off. Userlist customers will generally require additional tools and services, including a quota increase, batch mode enabling and userlist utility software. These items and services can be purchased via the online Store page.
Having selected the users you wish to be able to read the document you plan to publish, you choose your other document settings and publish the file. The DRM that is created can be sent to anyone, but will only be readable by those users with a Drumlin userID that matches an IDs in the list. The users must, of course, be pre-registered with Drumlin, and the userID provided in advance to the person publishing the document. The userID is the numerical last part of the Registration information, provided in the registration email and viewable via the Help menu, About form. Publishers wishing to use this facility are advised to include themselves in the list in order to be able to check the file is OK, and to be careful to include all the userIDs they require – if users are to be added or deleted, a new file should be created (please contact us if you need to amend the list for an existing file but cannot easily re-generate it). We suggest use of file expiry in combination with the facility, for extra security.
Batch publishing

Multi-file publishing

Typically a single document at a time is published, but multiple selection of documents and a batch publish facility (which assembles a document list from directory/subdirectory scanning) are also provided. To use the multiple file selection option, simply use the file browser when selecting files and hold down the Ctrl or Shift keys, as appropriate, to pick multiple files. Note that all files in a multi-file publish operation will have identical security settings.

Batch file publishing

Bulk publishing is essentially identical to single document publishing, with each document generating a separate exchange of data with the DRM server. If the Batch Publishing option is enabled (this generally has to be enabled from our DRM server) then an automated facility for file publishing can be used. This facility operates in two stages. The first stage is creating a list of files to publish, and the second stage is instructing Drumlin to proceed with the process. Batch file processing is not currently available for DRMZ files.

The screen shot below illustrates the list generation stage. A special batch publish form is displayed and you can select the source directory (where the PDF files will be found) and the destination directory (where the published DRM or DRMX files will be saved). The Generate File List button starts a scanning process on the source directory AND its subdirectories (as can be seen from the screenshot). As each PDF file is located it is added to the list and if it is under 300Mbytes in size a green tick is shown and the filename listed in grey, otherwise a green tick is displayed and the filename is displayed in red. Any very large files should be either reduced in size (e.g. using the Adobe Acrobat File menu, "reduce file size" option) or split using a proprietary file splitter. The inclusion of all ticked files is assumed, but files may be un-ticked and thereby excluded, as required. The Sel: field shows how many files have been selected and will be included when batch publishing commences. Note that all files in a batch publish operation will have identical security settings.

![Source Destination](image)

Once the file list has been finalized press OK to create the secured files. If there are a very large number to generate, e.g. 100+, we recommend you do a smaller test run first. You can repeat the exercise any number of times, but each file takes a few seconds to publish, and as this includes communicating metadata to and from the DRM server it may be advisable to leave the process running overnight. On completion check the files to ensure they have the attributes required. If files are created as Basic DRMs with a userlist, ensure you include your own
userID (as publisher) in the userlist so you can test the files once they are generated.

Notes: Batch publishing may require an increase in your publishing Quota settings; Batch publishing of .DRMZ files is not currently supported.
Keeping track

To help you keep track of the files you have published and their permission settings, a log file called PublishingHistory.csv is created and updated in your application data directory:

C:\Documents and Settings\<username>\Application Data\DrumlinSecurity\Drumlin

You can open this file with Excel or a text file editor (e.g. Notepad) and see each event with the various settings field names included in the first row:

Publ.Date,DocID,File,Description,Name,Version,ISBN,Type,StartDate,ExpiryDate,Print#,View#,Pages#,Keep Ver,MustBeOnline,MustBeRegistered,AllowNetworkPrinting

The menu item, Tools|Document History opens this file in a multi-tabbed grid, as illustrated below. Each tab provides a list of the documents, by type, and is sort-able by clicking the field name at the top of the columns. Double-clicking the filename will either open that file or the directory where the log file expects it to be found, if opening it is not possible (e.g. the file has since been deleted or moved).

In addition to locally logged publishing details, information relating to the use of Drumlin is kept in your application data directory:

C:\Documents and Settings\<username>\Application Data\DrumlinSecurity\Drumlin\Log

This information, and your settings configuration information, can be readily retrieved via the Drumlin menu item, Help|About.. and then clicking on the SEND LOG FILES button. This generates an email with two attached files that can be opened: the current drumlin.log and settings.cfg files (both being standard text files).

The Drumlin DRM server also retains information regarding publishing events, as it holds the metadata associated with each file published (all files published using Drumlin are assigned a unique Document ID (DocID) by the server, and when a document is authorized by an end user this information is also logged centrally. Reports can be produced from the central server relating to the usage of secured PDFs.
Reporting and control

The Drumlin DRM server tracks a considerable amount of information regarding the publishing, authorization and subsequent use of secured PDF files. All of this information can be used to create management reports - for example, with DRMX and DRMZ files we can report who used which codes and when from what IP Address, or when a specific user ran Drumlin last whilst having an active internet link, or where a document has been specified as "Must be online", when this file was last viewed and by whom. The most common request we have is for a list of the status of authorization codes for one or more published documents. This identifies which codes have been used and which remain available. Where so requested the central server can be used to disable particular Drumlin users, documents and/or client software versions. We can also generate special codes or blocks of codes, reset codes, report on codes used and unused etc.
Web hosting secured files

Once a secured file has been created it is ready for distribution. A fully secured DRMX or DRMZ file, a userlist protected DRM file, or a "Click and Go" exe file may all be distributed by any convenient means - all are protected and cannot be read until suitably authorized. Very often distribution will be via a web link from which the file may be downloaded, but it may also be via email, on CD or USB/solid state disk for example. A hosting service for DRMX or DRMZ files, with e-commerce support, is available from Drumlin Security Ltd on our website and our PDFZ.ORG and DRMZ.NET filestore services. Third party digital file distribution services can also be used.

If files are to provided via a web site link, either an open link accessible to anyone, behind a login/password security wall, or from a shopping cart application, then it is important to bear in mind that some file types are not directly supported on some server types and/or may present end users with downloading problems.

DRM and DRMX or DRMZ files: If you have placed a DRM (or DRMX/DRMZ) file on a web server but the link to it does not work/will not prompt the user to download or open the file then the problem may be caused by your web host not recognizing these file extensions. There are three options for resolving this issue: (i) ask your web server administrator to enable these extensions - Linux/Unix servers are generally OK but Windows servers require a MIME type declaration of application/octet stream; (ii) place the files on a separate file server that does not have these restrictions; or (iii) place the file(s) in a zip folder and link to this zip file rather than the DRM or DRMX or DRMZ file(s). Also note that whilst Windows-based web servers are not case sensitive, Linux/Unix servers are.

EXE files: It is advisable to place "Click and Go" exe files inside a zip file for downloading. This is because many browsers and virus checkers issue error messages or warnings about running programs they have not seen before, or worse still, they may simply delete them before they can be run. If this proves still to a problem, the virus checker can be turned off before downloading, the exe run, and then the virus checker turned on again. In most cases this will resolve such problems!
Re-publishing secure PDFs

Although some PDF files are very static, in the sense that once they have been produced they are rarely if ever changed, in other cases changes occur more or less frequently. If a source PDF is simply re-published using Drumlin then in general it will keep the same Document ID as the previous version. This means that authorization codes issued for that document will still work. However, if the newly generated secured PDF is a DRMX file it will have been allocated a new encryption key, part of which is stored on the server and part stored within the document. This is fine, but it does mean that previously issued drmx files with the same DocID can no longer be authorized, as their encryption key section will not match the newly generated code. The result is that users attempting to authorize the file see it 'almost' working but never completing correctly, and generally they will receive an "authorization code already used" message fairly soon after they try to use the out-of-date file. This does not happen with .DRMZ files, as they do not use a split key protection system.

To resolve problems with .DRMX file distribution, which might affect people with files distributed on CD some time ago, the end user would need to download a copy of the new version of file, and authorize or re-authorize this, as appropriate. In most cases this issue will not arise. Alternatively, create .DRMZ files and the problem will not occur.

For documents that change relatively frequently, it is often best to use a new source file name for each version, e.g. mydoc.pdf, mydoc_1.pdf mydoc_2.pdf etc. It is also possible to force Drumlin to generate a new docID for a file that has already been published, by ticked the Keep version option on the document type tab. Both these approach yield new docIDs, for which new authcodes would generally be required.
Part IV

Publishing Javelin and "Click and Go" files
Publishing Javelin and "Click and Go" files

Typically you will publish your files as DRMZ files, and distribute these to your customers together with a link to the javelin downloads page our website (or the relevant App Store) so that customers can download the appropriate Javelin reader for their computer or mobile device (e.g. iPAD and Android devices). The alternative to Javelin plus a secured PDF is a Javelin "Click and Go" exe file. This is a single executable image (an exe file or 'app', for Windows computers only) that comprises the Javelin PDF reader for Windows together with a secured PDF (DRMX file) embedded within it. You can only create exe files from files for which you are the publisher (i.e. your userID must match the ownerID, which essentially requires you to use the same PC for creating secured files and for making exe versions of these files). Security permissions relating to documents published using Javelin are specified using the secure publishing facilities within Drumlin when the DRMX is created. Most of the security features in Drumlin are supported in Javelin. In general we recommend that publishers avoid using the exe file approach, despite its attractions. Exe files have disadvantages - notably it is difficult to provide technical support as the file is a single entity rather than a separate program and data file, and the exe files may not be accepted as 'safe' by customer PCs (security software may reject or quarantine such exe files).

A Javelin DRMX or DRMZ file must be run from the computer on which it has been authorized. If it is moved to another computer and run it will ask for a new authorization code (see also, Other authorization options). If you create a DRMX or DRMZ file, authorize it with Javelin, and view it, the registry will contain information about that DRMX or DRMZ included some unique encryption information. If you re-generate the DRMX, using the same or different settings, this unique code information will change and when you try to open it with Javelin it will issue an error message. This can be avoided by either deleting the entry for that document in the registry (via the Remove Authorization option which is provided for this purpose) or by creating the re-published file with a new name (generally you will need to use a source PDF with its name altered) and thus a new docID and new authorization codes will apply. The latest releases of Javelin handle this issue automatically (see further, below - note B).

If you create the DRMX or DRMZ file using Drumlin and distribute this file then ensure the user also downloads the appropriate Javelin program for their hardware platform. In this case they run Javelin and use the File menu, Open option, to open the DRMX or DRMZ and authorize, as described earlier. The main advantages of opting for the separate Javelin reader+DRMX or DRMZ route are:

(a) the Javelin application is only downloaded once, so any warning messages to the user or related technical issues will only occur once rather than with each "Click and Go" exe download, and the secured PDF files (DRMX or DRMZ files) downloaded will always be somewhat smaller;

(b) the same procedure will work for Windows, Mac, iPAD and Android tablet device users

(c) users are familiar with this mode of working with many other software products, including the Adobe reader, Word etc;

(d) enhancements to the reader (e.g. markup, updates to support operating system upgrades) can be provided subsequently to new and existing users, without the need for all documents to be re-generated and re-downloaded

IMPORTANT NOTES:

A. Drumlin Version 5 DRMX files cannot be opened using Javelin. Publishers should re-generate any existing DRMX files they wish to publish for Javelin usage with the File\Open option. New DRMX files must be created with the Drumlin Version 6 kit, although V5 DRMX files can be used if just an EXE is to be generated. Also, note that if a version 5 DRMX has been converted to a version 5 "Click and Go" exe file, the new file generated using Drumlin V6 should also be an exe. Javelin will not open a new format DRMX file if an existing V5 exe has been authorized on that computer. If necessary this can be resolved by changing the name of the source PDF, republishing it with Drumlin V6, and then this file will have a new Document ID (DocID) and will thus be recognized by Javelin as a valid file that can be authorized and opened.

B. Drumlin DRMX files and EXE files that are re-issued can be opened using Javelin but require re-
authorization. Publishers who for some reason have to re-issue a DRMX file that is to be read using Javelin or which has been turned into a Windows exe file for distribution, need to be aware that this will result in a file warning message and the option to re-authorize the file. This is because each time a DRMX is created a unique encryption code is used. Thus even if the same document is published (and thus has the same docID) the Javelin software will not recognize it as valid. The latest versions of Javelin for Windows recognizes this issue and offer the option to re-authorize the document. There are two alternatives to this: (i) make sure you create a new file, i.e. a file with a new docID, and issue this instead. To do this, give your source PDF a new name, e.g. <oldfilename>_1.pdf and re-generate the drmx file, then send this (or an exe produced from it) to the user(s). A new authorization code will be required, which will be for the new docID. If necessary we can re-assign authorization codes from an old version of a file to a new version (on request); or (ii) use a new utility called JavelinUtility.exe to effectively "uninstall" an earlier version of a file authorized with Javelin. The new version can then be opened by the end user, and again they will be prompted for an authorization code. The utility program can be downloaded from the main Downloads page on the website.

C. Javelin "Click and Go" exe files are created from Drumlin DRMX files and are only available for Windows users. The process is as follows:

1. create your PDF from your source document, preferably using Adobe Acrobat software - some PDF creators produce very poor files that may either fail to load in Drumlin and some other readers, or load very slowly. If in doubt, first try opening the PDF in Drumlin and/or Javelin using the File menu, Open option.

2. use the Drumlin File menu, Publish option, Publish Documents... item to create a secure DRMX file - see the earlier section on Publishing Secure PDF files for more details. Make a note of the DocID that is generated, and/or save the test code provided to disk (the best idea) as this includes a 5x usage test code and document details. The document details can also be retrieved from the document tracking facilities. Also note that most, but not all, DRMX controls are supported in the "Click and Go" reader (currently "must be online" is not supported, but may be added in the future)

3. use the File menu, Publish option, Create exe item to bring up the Create Exe form, as shown below:

4. Select the DRMX file you wish to publish as an exe, using the [...] button to browse for the file. The exe file name will be defaulted to the same name as the DRMX file but you can amend this if you wish (the latest versions of Drumlin permit multiple exe files to be created in one pass - see the website Downloads page to obtain a copy of this release).

5. The BIN file entry will be defaulted to the file last used or DrumlinCaG.bin - this is the Javelin reader that the DRMX file is going to be embedded into. If you have a branded reader you will choose the BIN file for that version here - for example MyReader.bin (bin stands for binary). Note that DrumlinCAG.bin is simple a
renamed copy of Javelin.exe, so you can simply rename the latest copy of Javelin.exe to DrumlinCAG.bin to obtain a usable BIN file that is the latest version of Javelin

6. Choose your authorization type. This will generally be Online authorization, i.e. will require the end user to enter an authorization code the first time they use the file. This code will be for the DocID noted in step 2, above

7. Press OK - the exe file will be saved and you can exit Drumlin and run the exe to test it. If you have used the Online authorization option then use the test code provided to check the file runs and authorizes as expected

8. Assuming all is fine, place your exe inside a zip file and distribute it via your preferred media (e.g. email, CD, USB disk or web download)

9. Order a block of authorization codes for that file (if authorization is required) via the online store: http://www.drumlinsecurity.com/store.html and distribute these to end users as and when required

Users of the Drumlin "Click and Go" software can manually change resampling method (from the default value=6/ Bresenham) by starting any CaG exe file with a command line switch of the form:

filename.exe -R12 or filename.exe -r5

The -R switch permanently sets resampling method (writes it to the registry) whereas the -r switch uses the set method only for the current session. Note that if you find your graphics look better using a resampler such as Mitchell (which is 10), then issuing your Javelin file using a setup program, with the startup set to filename.exe -r10 will ensure this graphics renderer will be used.

Command line values are also available for setting the default language, e.g. to Arabic or Chinese (traditional).
Command line options

The following comments apply to the Windows version of Javelin only.

If Javelin includes an embedded secure PDF, e.g. myfile.drmx, the executable file will be myfile.exe. In either case the program can be modified at startup by the addition of command line parameters. The standard Javelin for Windows install kit is provided as a convenient way of ensuring that the Javelin.exe file has desktop and Start menu links, and includes file association for .DRMX and DRMZ files (i.e. if such files are double-clicked the file is opened using Javelin). Currently the command line options included in the kit for the shortcut links include -R6 and -E (see below).

Currently a number of optional parameters can be defined:

Filename

-F<filename> defines a file to open when Javelin is run

Graphics mode

-r or -R:

With these parameters the default rasterization algorithm is changed to use a preferred algorithm. For some PDF files this can result in improved display of images, especially when zooming in or out. The -r parameter is temporary and just applies to the currently launched exe, whilst -R sets the selection as the default within the Windows registry. To select a specific algorithm it must be assigned a value which are the same as those used in the main Drumlin PDF reader (settings file). entries are thus of the form -r6 or -R10 (6, Bresenham, is the default for the latest Javelin kit). The available values are:

- Box = 0,
- Bell = 1,
- CatmullRom = 2,
- Cosine = 3,
- CubicBSpline = 4,
- CubicConvolution = 5,
- Bresenham = 6,
- Hermite = 7,
- Lanczos3 = 8,
- Lanczos8 = 9,
- Mitchell = 10,
- Quadratic = 11,
- QuadraticBSpline = 12,
- Triangle = 13

Extended menus

-E

this option, which is now standard in the latest Javelin for Windows kit, ensures that the full menu of options is displayed on the File menu (i.e. including connection options and log file access). For branded readers this can be enabled or disabled, as required.

Print resolution

-Pnnn

this option enables the default print resolution of 300dpi to be over-ridden with the value nnn, typically this would be 600, but could be a lower or higher target resolution than 300. Example: -P600
Language

-l or -L:

With these parameters the default language used can be set. The structure is similar to that described above, with the language values being:

0 - english
1 - croatian
2 - german
3 - spanish
4 - french
5 - japanese
6 - chinese (traditional)
7 - chinese (simplified)
8 - arabic
9 - danish
10 - italian

Note: The numbers shown above are those that should be used to set the default language - this differs from the order in which languages are displayed in the Tools menu of Javelin, as these are shown alphabetically.

Using a simple setup program a Javelin "Click and Go" exe, which includes an embedded secure PDF, can be distributed to end users with the preferred command line parameters preset plus a Desktop and Start menu link to the file. For a more sophisticated result, for example including passing the command line arguments,

"The Little Prince" download on our samples page uses Inno Setup, a freeware installation utility, to install this Javelin ebook (107 pages) and launches it with the French version of Javelin (using the -l4 command line option). A desktop link to the ebook is also provided. The script file for this installation is provided below:

; Le Petit Prince - Sample Script for Inno Setup Program
[Setup]
AppName=Le Petit Prince
AppVerName=Le Petit Prince
DefaultDirName={userdocs}
DisableProgramGroupPage=yes
OutputDir={userdocs}:Inno Setup Examples Output
[Files]
Source: "C:\MyBooks\LePetitPrince\le_petit_prince.exe"; DestDir: "\{userdocs\}"
[Icons]
Name: "\{userdesktop\}:Le Petit Prince"; Filename: "\{userdocs\}:le_petit_prince.exe"; Parameters: "-l4"
[Run]
Filename: "\{userdocs\}:le_petit_prince.exe"; Parameters: "-l4"; Description: "Launch application"; Flags: postinstal
Part V

Antivirus software issues
Antivirus software issues

All our software products are checked to ensure they are virus free. Drumlin, Javelin and the distribution kits are "signed" applications for Windows.

Norton Antivirus users (and maybe some others, occasionally) - if your antivirus software will not accept a download from us or deletes it/places it in quarantine, we are certain that this is a false positive. Please report this to Symantec as an error. To resolve this please either turn off the offending behaviour in Norton's software (Insight and/or SONAR) or recover the quarantined file from within Norton Antivirus, or use another antivirus product like AVG!

To check any file you are concerned about against 40+ AV software packages, without charge, we suggest that you use the website: http://www.virustotal.com/index.html

If you are distributing "Click and Go" exe files it is possible that your end users will have this kind of problem also. You can use Virustotal to check your files before issuing them, and then use the advice here to address your end users questions, if these arise. You can also choose to distribute Javelin and the DRMX or DRMZ files separately so that only one exe, i.e. Javelin.exe, is ever checked.
Part VI

Other authorization options
Other authorization options

Javelin "Click and Go" exe files can be created using two other options for authorization.

No authorization required

The simplest is to choose "No authorization" in which case the document can be run immediately by anyone receiving it on a PC running Windows or a device running a Windows emulator (e.g. a Mac OS X computer running Bootcamp). This is ideal for demonstration files (e.g. extracts of books) or files that you are happy for anyone to have but with some control over their usage. For example, by including an early expiry date when creating the source DRMX file the exe you generate will have the same expiry date - the same applies to other features, such as restricting printing or copying.

Off-line authorization

Off-line authorization is a limited security mechanism, one step up from no authorization because once authorized the file is locked to the user's PC. It allows the publisher to create a unique authorization code of the form used by many software license products. The end user does not need an online connection to complete the authorization process, but this also means that there is no Digital Rights Management process in operation. For fully secure files the use of online authorization is required. The steps to create an offline authorization "Click and Go" exe file are as follows:

1. use the same steps as per creating online authorized "Click and Go" files, but select off-line authorization

2. when an end user orders/requests a code from you, the publisher, you create a unique license code for them using the Drumlin menu item, Tools, Calculate Hash... this prompts you to select the DRMX file that was used to create the exe, and then displays the following form:

   ![HashCalc](image)

   3. with this form you enter a username that has been assigned to this person and their email address, and then press Calculate. You can use the Clipboard button to copy the license code that is generated to the clipboard and then include it in your reply email to the customer

4. the customer replicates this process when they try and run an offline authorized "Click and Go" file, entering the same username and email address that you used, and then paste-ing in the license code they have been provided with. The file is then authorized and they can use it
Catalogs

Catalogs are collections of documents (books, courseware materials) plus associated metadata, i.e. data about these documents, such as the document name, description and/or ISBN.

A Catalog is an xml structured text file. It can contain:

- The catalog name and where to locate it (its URL)

- A list of documents that are available for download, defined within the XML structure explained below. Elements that may be provided for each document include: its location for downloading (its URL); the URL of a thumbnail image (cover image) for that file; details about the document or item (name, long description, date of publication etc)

- Another catalog name and its URL – this enables catalogs to be nested within other catalogs and facilitates longer (descriptive) catalog names

- A catalog can also be provided as a zip file. In this case the catalog includes a standard XML catalog plus additional resources, notably a set of document cover images, thereby enabling both the catalog and covers to be downloaded in one go. Zipped format catalogs can contain other resources, such as PDF and DRMZ files, so provide a more general function subject to practical issues of downloading large files of course (see samples below for more details)

Publishers can produce their own xml catalogs and download or copy these to Javelin, and then test downloading their own PDFs and secured PDFs (DRMZ files). If the publisher wishes the PDF to be secured (i.e. converted to a drmz file) they need to contact Drumlin Security for this facility or use the Drumlin software available as a free download from the Drumlin Security website. They will also need to contact Drumlin Security in order to obtain the authorization codes that are required for each file and/or to obtain access to the AdminApp program in order to generate their own codes.

Catalogs display covers after downloading, assuming cover images have been made available. If covers are not displayed, press the catalog refresh icon to obtain them. Catalogs that are in the new zip file format should include the covers as part of the zip file, and in this case both catalog and covers are downloaded. Note that this feature requires the user to have the latest versions of the Javelin app to ensure the catalog download is correctly processed. If in doubt, existing customers should be asked to update their copy of Javelin before refreshing an existing catalog that has been updated to include zip elements and/or before downloading a new zip-format catalog.

A sample catalog XML file is included below. This can be created and edited using a standard or advanced text editor – for example, we use and recommend Notepad++, which is an excellent free text editor for the PC platform:

http://notepad-plus-plus.org/

Note that text within bracketed fields should not contain “&” characters, and for some fields inclusion of full stop (period) character, angle brackets <, > etc. Catalogs may be updated at any time using the Refresh icon. Catalog files, once created, can be converted into a secured form if so required. This is achieved using a utility program available from Drumlin Security Ltd, which simply converts an XML file to an XMLZ file. The latter is provided if a publisher wishes to hide the contents of their catalog from open viewing.

SAMPLE STANDARD FORMAT CATALOG XML FILE

```xml
<?xml version="1.0" encoding="UTF-8"?>
<JavelinCatalog>
  <CatalogURL>http://www.drumlinsecurity.co.uk/ipad/catalog.xml</CatalogURL>
  <Document>
    <Name>Alice in Wonderland - Test Code: abacabcabc</Name>
  </Document>
</JavelinCatalog>
```
In addition to <Document> sections that point to PDF and DRMZ files, you can now include within the same structure an entry of the form:

<URL>URL of another catalog, with .xml extension</URL>

for example:

<Document>
    <Name>Management Pocketbooks</Name>
    <URL>http://www.pdfz.org/mpbooks.xml</URL>
    ......
</Document>

When the original catalog is parsed after being downloaded, it recognizes the .xml extension and will use the cover image to provide access to the second level catalog. When the cover is touched this second level catalog is downloaded and will contain its own set of PDFs and secured PDFs. Thus catalogs can be nested, e.g.:
MyCatalog
   Science Fiction
   Fantasy
   Classics
   Biography etc

SAMPLE ZIP FORMAT CATALOG XML FILE

A sample zip format catalog file, with almost 100 entries and covers, can be downloaded from:

http://www.pdfz.org/mpbooks.zip

When downloaded and opened it can be seen that the zip file contains a standard xml catalog file, plus a folder with the same name plus the extension .catdir – this folder or sub-directory contains all the cover images as .png files. It is possible to include other resources within the .catdir folder - for example, PDF files or DRMZ files. However, consideration should be given to the possible size of the zip file to be downloaded. In the mpbooks example each DRMZ file is between 5Mb and 10Mb, so if all the books were included in the downloadable zip file it could be several hundred Mbytes, which is not reasonable as a download for most users and networks. A standard xml catalog can include .zip as well as .xml files as downloadable items, enabling both standard and zip-format catalog files to be included as sub-catalogs within a main catalog.
Part VIII

Authorization codes and Admin facilities
Authorization codes and Admin facilities

Secure PDF files require some form of authorization process to ensure they are only readable by the intended target individual and/or on a single computer or mobile device. Without such authorization files can be copied to other computers/individuals, which is generally not the desired result. With the Javelin software, secured PDFs that have view or print count limits may be "re-authorized" when their quota of views or pages expires by entering a new authorization code (users will be prompted automatically by the software for a new code). Re-authorization under these circumstances effectively re-sets the view and/or print count back to its original setting.

Standard authorization codes

Authorization codes for DRMX files are 20 character random alphanumeric strings. Authorization codes for DRMZ files (for cross platform usage, including iPads) are 9 character alphanumeric codes with only lower case characters plus numbers, but are otherwise similar to the codes used for DRMX files. NOTE: Codes for DRMX files MUST be 20ch, whereas for DRMZ files the length is not checked - they are typically 9 characters but a 20ch DRMX code for a given DocumentID will work for a DRMZ file with the same DocumentID.

Each code is associated with a specific PDF document via that document’s DocID key. As long as codes are stored as entries in the Authcodes table within the SQL database, and meet the length criteria, they can be of almost any format. For example, the code 123456789 can be used for as many different DRMZ documents as required, subject of course to having a usage count of 1 or more and a documentID entry in the database to associate the code with a specific document. Special codes, like 123456789, can be created on request to Drumlin Security but not otherwise.

When a file is authorized the code entered is checked against the entry on the relevant DRM server. If the code matches for the document being authorized, and the Counter value is >0, the file is authorized and can be read on the end user’s PC thereafter. On the server the counter for this code is reduced by 1 and so becomes 0. If the user attempts to use the code again the value on the server is found to be 0 so the message "authorization code already used" is issued. However, on request from the publisher (e.g. if the customer has had to replace their computer or operating system) the code can be reset (to 1). Also, if requested at the start, counters can be set to any value, such as 5. When a DRMX or DRMZ file is published a free test code is provided and this has a counter of 5 set as its default, precisely so it can be used more than once (e.g. to test a DRMX file and an exe, and to test the files with initial customers).

Because many customers require their authorization codes as a simple list, ready for use within an automated procedure, the authorization code files distributed are provided as a text list with a filename of the form:

<docname>_<docID>.txt

or

<docID>.dac

whichever format is preferred. The entries within the file are then just NNN lines of 20 character codes, e.g. 100 lines of codes that apply for that particular docID.

If a list of authorization codes are generated using the latest versions of the AdminApp and there is already a file with that name on the local directory, the program will add an increment to the filename, e.g. _1, _2 etc.

If preferred, authorization codes can be generated for multiple documents, such that the codes created are the same for each document (we refer to these as "common codes"). This allows the publisher to provide a single code to an end user that may be used for several documents, which otherwise would have required issuing different codes for each document.

User-specific authorization codes
In general authorization codes are document specific and not user specific. This means that the code can be sent to a registered user without having to know what their userID is. However, for Enterprise server customers and for corporates using a managed service, we can specify that a given authorization code can only be used by a specific userID (a Drumlin user), which then locks its usage to that individual.

Off-line authorization codes

For off-line authorization codes, as used in some "Click and Go" exe versions of Javelin, see the off-line authorization section.

Download mode authorization

Authorization of fully encrypted PDF files can be made without requiring authorization codes if: (a) the files in question have been previously uploaded to the Drumlin DRM server using the Drumlin Admin program; (b) the target user is registered on the Drumlin server and has the Downloads menu item (on the file menu) enabled; and (c) the document in question has been enabled for that particular user.

Automated distribution of authorization codes

In many cases publishers do not wish to manually issue authorization codes. The process can be automated in several ways. First of all, if you have your own website from which the products are sold, your website developer can include software to provide "digital delivery" of your products. This will typically involve some level of additional programming to include a list of available authorization codes from which the next code is picked when an order is placed. Second, the software house Vibralogix is one of a number of companies who provide very low cost software that may be used to perform this function for you (see http://www.vibralogix.com/linklokipn/ for more details). A number of our customers use this method and our own "Managed Service" offering uses this software.

Finally, you can also use download services, such as DPD (http://getdpd.com/'), PayLoadz (https://www.payloadz.com/'), Softseller (http://softseller.com/SS/) and e-Junkie.com who provide this kind of functionality on a service basis, for a fee.